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Using This Manual

1. The Contents of This Manual

This document provides information about using the ANSYS POLYFLOW application within ANSYS

Workbench.

A brief description of what is in each chapter follows:

• Getting Started with ANSYS POLYFLOW in ANSYS Workbench (p. 1), describes an overview of POLY-

FLOW within Workbench.

• Working with ANSYS POLYFLOW in ANSYS Workbench (p. 15), describes the details of using POLYFLOW with-

in Workbench.

2. Typographical Conventions

Several typographical conventions  are used in this manual’s text to facilitate your learning process.

• Different typographical fonts are used to indicate graphical user interface menu items and text inputs

that you enter (e.g., Flow boundary conditions menu, enter the name fluids ).

• In POLYDATA and Workbench, a mini flow chart is used to indicate the menu selections that lead you

to a specific panel. For example:

File → Options

indicates that the Options menu item can be selected from the File pull-down menu at the top

of the POLYDATA console window.

The words before the arrow invoke menus (or submenus) and the arrows point from a specific

menu toward the item you should select from that menu.

3. Contacting Technical Support

Technical Support for ANSYS, Inc. products is provided either by ANSYS, Inc. directly or by one of our

certified ANSYS Support Providers. Please check with the ANSYS Support Coordinator (ASC) at your

company to determine who provides support for your company, or go to www.ansys.com and select

About ANSYS> Contacts and Locations. The direct URL is: http://www1.ansys.com/customer/public/sup-

portlist.asp. Follow the on-screen instructions to obtain your support provider contact information. You

will need your customer number. If you don't know your customer number, contact the ASC at your

company.

If your support is provided by ANSYS, Inc. directly, Technical Support can be accessed quickly and effi-

ciently from the ANSYS Customer Portal, which is available from the ANSYS Website (www.ansys.com)

under Support> Technical Support where the Customer Portal is located. The direct URL is: ht-

tp://www.ansys.com/customerportal.

One of the many useful features of the Customer Portal is the Knowledge Resources Search, which can

be found on the Home page of the Customer Portal.

Systems and installation Knowledge Resources are easily accessible via the Customer Portal by using

the following keywords in the search box: Systems/Installation . These Knowledge Resources

provide solutions and guidance on how to resolve installation and licensing issues quickly.

v
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NORTH AMERICA

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Toll-Free Telephone: 1.800.711.7199

Fax: 1.724.514.5096

Support for University customers is provided only through the ANSYS Customer Portal.

GERMANY

ANSYS Mechanical Products

Telephone: +49 (0) 8092 7005-55

Email: support@cadfem.de

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

National Toll-Free Telephone:

German language: 0800 181 8499

English language: 0800 181 1565

International Telephone:

German language: +49 6151 3644 300

English language: +49 6151 3644 400

Email: support-germany@ansys.com

UNITED KINGDOM

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +44 (0) 870 142 0300

Fax: +44 (0) 870 142 0302

Email: support-uk@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

JAPAN

CFX , ICEM CFD and Mechanical Products

Telephone: +81-3-5324-8333

Fax: +81-3-5324-7308

Email: CFX: japan-cfx-support@ansys.com; Mechanical: japan-ansys-support@ansys.com

FLUENT Products

Telephone: +81-3-5324-7305

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.vi

Using This Manual

http://www.ansys.com/customerportal
http://www.ansys.com/customerportal
http://www.ansys.com/customerportal


Email: FLUENT: japan-fluent-support@ansys.com;POLYFLOW: japan-polyflow-support@ansys.com;FfC: japan-

ffc-support@ansys.com; FloWizard: japan-flowizard-support@ansys.com

Icepak

Telephone: +81-3-5324-7444

Email: japan-icepak-support@ansys.com

Licensing and Installation

Email: japan-license-support@ansys.com

INDIA

ANSYS Products (including FLUENT, CFX, ICEM-CFD)

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +91 1 800 233 3475 (toll free) or +91 1 800 209 3475 (toll free)

Fax: +91 80 2529 1271

Email: FEA products: feasup-india@ansys.com;CFD products: cfdsup-india@ansys.com; Installation: installation-

india@ansys.com

FRANCE

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.
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Chapter 1: Getting Started with ANSYS POLYFLOW in ANSYS

Workbench

This document is designed to provide information about using ANSYS POLYFLOW within ANSYS Work-

bench. Some basic information about using Workbench is provided here, but the majority of the inform-

ation about using Workbench can be found in the Workbench online documentation.

This chapter provides some basic instructions to help you start using ANSYS POLYFLOW in ANSYS

Workbench.

1.1. Introduction to ANSYS Workbench

1.2.The Workbench Graphical User Interface

1.3. Creating POLYFLOW-Based Systems

1.4. Understanding Cell States with POLYFLOW in Workbench

1.5. Starting POLYFLOW Applications in Workbench

1.6. Saving Your Work in POLYFLOW with Workbench

1.7. Exiting POLYDATA and Workbench

1.8. An Example of a POLYFLOW Analysis in Workbench

1.9. Getting Help for POLYFLOW in Workbench

1.1. Introduction to ANSYS Workbench

ANSYS Workbench combines access to ANSYS applications with utilities that manage the product

workflow.

Applications that can be accessed from Workbench include: ANSYS DesignModeler (for geometry creation);

ANSYS Meshing (for mesh generation); ANSYS POLYFLOW (for setting up and solving computational

fluid dynamics (CFD) simulations, where viscous and viscoelastic flows play an important role); and

ANSYS CFD-Post (for postprocessing the results). In Workbench, a project is composed of a group of

systems. The project is driven by a schematic workflow that manages the connections between the

systems. From the schematic, you can interact with workspaces that are native to Workbench, such as

Design Exploration (parameters and design points), and you can launch applications that are data-in-

tegrated with Workbench (such as POLYFLOW). Data-integrated applications have separate interfaces,

but their data is part of the Workbench project and is automatically saved and shared with other applic-

ations as needed. This makes the process of creating and running a CFD simulation more streamlined

and efficient.

Workbench allows you to construct projects composed of multiple dependent systems that can be up-

dated sequentially based on a workflow defined by the project schematic. For instance, you can construct

a project using two connected POLYFLOW-based systems where the two systems share the same geo-

metry and mesh; and the second system uses data from the first system as its initial solution data. When

you have two systems connected in this way, you can modify the shared geometry once and then update

the results for both systems with a single mouse click without having to open the Meshing application

or POLYFLOW. Some examples of when this is useful include: performing a non-isothermal flow calcu-

lation starting from the solution obtained from an isothermal one; performing a transient calculation

starting from the solution obtained from a steady-state analysis; and performing a blow molding simu-

lation using the parison obtained from an extrusion calculation.
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Additionally, Workbench allows you to copy systems in order to efficiently perform and compare multiple

similar analyses. Workbench also provides parametric modeling capabilities in conjunction with optim-

ization techniques, which can allow you to investigate the effects of input parameters on selected

output parameters; however, it is recommended that you utilize POLYFLOW’s internal parameterization

and optimization capabilities if possible, in order to minimize the computational expense. See the

POLYFLOW User’s Guide for details.

1.1.1. Limitations

The following limitations are known when using POLYFLOW in Workbench:

• Care must be taken with regard to the handling of units. You can specify the length unit system in the

ANSYS DesignModeler and ANSYS Meshing applications, but these units are not taken into account in

POLYDATA and POLYFLOW; POLYDATA and POLYFLOW ignore the system of units, and only require that

you are consistent in the units you apply. POLYDATA does have a unit conversion utility, but it only affects

the data entered in the Material data menus. You are required to specify the unit system that will be

exported to ANSYS CFD-Post, though this specification will not have any impact on the numerical values

of the fields in the ANSYS CFD-Post files.

• The version of POLYFLOW started from within Workbench will always be the version of POLYFLOW that

is installed with the current version of Workbench being run.

1.2. The Workbench Graphical User Interface

The Workbench graphical user interface (Figure 1.1 (p. 3)) consists of the Toolbox, the Project Schem-

atic, the Toolbar, and the Menu bar. The most common way to begin work in Workbench is to drag an

item, such as a component system (application) or an analysis system, from the Toolbox to the Project

Schematic, or to double-click an item to initiate the default action. You will view your component and/or

analysis systems – the pieces that make up your analysis – in the Project Schematic, including all con-

nections between the systems. The individual applications in which you work will display separately

from the Workbench graphical interface, but the actions you take in the applications will be reflected

in the Project Schematic.

Important

Note that POLYFLOW can be accessed in Workbench as either a component system or as an

analysis system. Details for using both are described throughout this document.
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Figure 1.1  The Workbench Graphical User Interface

1.3. Creating POLYFLOW-Based Systems

There are two basic types of systems: analysis systems and component systems. The Fluid Flow

(POLYFLOW) analysis system allows you to perform a complete CFD analysis and contains cells that

allow you to: create geometry, generate a mesh, specify settings in POLYDATA, run the POLYFLOW solver,

postprocess solution data plots in POLYCURVE or statistical information in POLYSTAT, and visualize the

results in ANSYS CFD-Post.

The POLYFLOW component system allows you to access the POLYFLOW application from within Work-

bench, and contains only the cells needed to specify settings in POLYDATA, run the POLYFLOW solver,

and postprocess solution data plots in POLYCURVE or statistical information in POLYSTAT. When using

a POLYFLOW component system, a mesh must be imported into the system or provided through a

connection from an upstream system. You must also connect the POLYFLOW component system to a

Results component system if you want to postprocess the results using ANSYS CFD-Post.

Note that there are template versions of POLYFLOW that are available as both analysis and component

systems. These templates are versions of POLYFLOW that limit the capabilities to only those needed to

set up and perform simulations of specific industrial processes, including the following:

• blow molding

This template is listed as Fluid Flow-BlowMolding (POLYFLOW) under Analysis Systems and as

POLYFLOW - Blow Molding under Component Systems.

• extrusion

3
Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Creating POLYFLOW-Based Systems



This template is listed as Fluid Flow - Extrusion (POLYFLOW) under Analysis Systems and as

POLYFLOW - Extrusion under Component Systems.

In order to use a template version of POLYFLOW, you must have a license for that template or the

standard POLYFLOW license. In terms of how you set up and utilize template systems in Workbench,

the information provided in the sections that follow about POLYFLOW-based analysis and component

systems applies equally to the analysis and component systems of POLYFLOW templates, respectively.

1.3.1. Creating POLYFLOW-Based Analysis Systems

You can create a Fluid Flow (POLYFLOW) analysis system in Workbench by double-clicking on Fluid

Flow (POLYFLOW) under Analysis Systems in the Toolbox.

Important

You can also create a Fluid Flow (POLYFLOW) analysis system by left-clicking on Fluid Flow

(POLYFLOW) under Analysis Systems in the Toolbox, and then dragging it onto the Project

Schematic.
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Figure 1.2  Selecting the Fluid Flow (POLYFLOW) Analysis System in Workbench

The new Fluid Flow (POLYFLOW) analysis system appears in the Project Schematic as a box containing

several cells (Figure 1.3 (p. 6)). Each cell corresponds to a typical task you would perform to complete

a CFD analysis. The following cells are available in a Fluid Flow (POLYFLOW) analysis system:

Geometry

allows you to define the geometrical constraints of your analysis. You can use the context menu (by

right-clicking on the cell) to import a pre-existing geometry into the system. Double-clicking on the

Geometry cell opens ANSYS DesignModeler where you can create a new geometry or modify an existing

geometry.

Mesh

allows you to define and generate a computational mesh for your analysis. Double-clicking on the Mesh

cell opens ANSYS Meshing and loads the current mesh database (or the geometry defined by the Geo-

metry cell) if you have not yet begun working on the mesh.

Alternatively, you can use the context menu (by right-clicking on the Mesh cell) to import a pre-

existing mesh into the system. The mesh formats that are allowed to be imported include POLY-

FLOW (.msh ), ICEM (.poly ), and GAMBIT (.neu ).
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Important

Importing a mesh file into the Mesh cell results in the Mesh cell becoming the starting

point for your analysis. Therefore, the Geometry cell (and data it contains) will be deleted

from the system.

Important

Meshes imported into the Mesh cell cannot be modified by the ANSYS Meshing applica-

tion.

Setup

allows you to define the physical models, material properties, boundary and process conditions, and

solver settings for the POLYFLOW analysis. Double-clicking on the Setup cell opens POLYDATA and loads

the mesh defined by the Mesh cell. Alternatively, you can use the context menu to import a pre-existing

POLYFLOW data file into the system (by right-clicking on the Setup cell and selecting Import POLYFLOW

Dat...); you can then open POLYDATA as previously described if you need to edit the data file.

When you are done creating, importing, and editing the data file, you must update the cell to

continue: right-click the Setup cell and select Update.

Note that you can open POLYMAT using the context menu (by right-clicking on the Setup cell and

selecting POLYMAT...), in order to perform preliminary material property analyses. Otherwise, you

can open POLYMAT from within the POLYDATA application in the usual manner (see the POLY-

FLOW User’s Guide for details).

Solution

allows you to calculate a solution using POLYFLOW. Right-click the Solution cell and select Update to

run the POLYFLOW solver using the current data file for input. If you want POLYFLOW to run in background

mode rather than the default foreground mode, before you select Update you must first right-click the

Solution cell, select Properties, and select Background Task for Update Option in the Properties of

Schematic <cell ID>: Solution pane that opens.

Note that you can open POLYCURVE and POLYSTAT using the context menu (by right-clicking on

the Solution cell), in order to postprocess the results of your POLYFLOW simulation.

Results

allows you to display and analyze the results of the CFD analysis. Double-clicking on the Results cell

opens ANSYS CFD-Post and loads the current POLYFLOW result file as well as the current ANSYS CFD-

Post state file.

Figure 1.3  A Fluid Flow (POLYFLOW) Analysis System
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Note

While it is possible to apply different names for any of the cells by right-clicking them and

selecting the Rename option in the context menu, it is not generally recommended to do

so.

1.3.2. Creating POLYFLOW-Based Component Systems

Similarly, you can create a POLYFLOW-based component system in Workbench by double-clicking

POLYFLOW under Component Systems.

Important

You can also create a POLYFLOW component system by left-clicking on POLYFLOW under

Component Systems in the Toolbox, and then dragging it onto the Project Schematic.

Figure 1.4  Selecting the POLYFLOW Component System in Workbench

The new POLYFLOW component system appears in the Project Schematic as a box containing two cells:

the Setup cell and the Solution cell (Figure 1.5 (p. 8)). The Setup and Solution cells in a POLYFLOW com-

ponent system work in similar manner to the description provided previously for the Fluid Flow

(POLYFLOW) analysis system. Note that the mesh must originate from a file imported into the Setup

cell, or it must be provided through a connection from an upstream system. You must also connect the

POLYFLOW component system to a Results component system if you want to postprocess the results

using ANSYS CFD-Post.
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Figure 1.5  A POLYFLOW Component System

1.4. Understanding Cell States with POLYFLOW in Workbench

Workbench integrates multiple data-integrated (e.g., POLYFLOW) and native applications into a single,

seamless project flow, where individual cells can obtain data from and provide data to other cells.

Workbench provides visual indications of a cell’s state via icons on the right side of each cell. Brief de-

scriptions of the each possible state are provided below. For more information about cell states, see

the Workbench online help:

• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first create

a new Fluid Flow (POLYFLOW) analysis system, all cells downstream of the Geometry cell appear as

Unfulfilled because you have not yet specified a geometry for the system.

• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update. For

example, after you assign a geometry to the Geometry cell in your new Fluid Flow (POLYFLOW) ana-

lysis system, the Mesh cell appears as Refresh Required since the geometry data has not yet been

passed from the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell, however,

you must take some action to proceed. For example, after you launch POLYDATA from the Setup cell

in a Fluid Flow (POLYFLOW) analysis system that has a valid mesh, the Setup cell appears as Attention

Required because additional data must be entered in POLYDATA before you can calculate a solution.

• Update Required ( ) indicates that local data has changed and the output of the cell must be regen-

erated. For example, after you launch ANSYS Meshing from the Mesh cell in a Fluid Flow (POLYFLOW)

analysis system that has a valid geometry, the Mesh cell appears as Update Required because the

Mesh cell has all the data it needs to generate a POLYFLOW mesh file, but the POLYFLOW mesh file has

not yet been generated.

• Up-to-Date( ) indicates that an update has been performed on the cell and no failures have occurred

(or an interactive calculation has been completed successfully). For example, after POLYFLOW finishes

performing the number of necessary solver iterations, the Solution cell appears as Up-to-Date.

• Interrupted ( ) indicates that you have interrupted an update (or stopped an interactive calculation

that is in progress). For example, if you select the stop button ( ) in the Progress Monitor of Work-

bench at a point where POLYFLOW has generated results but has not yet completed the calculation

(such as during a transient simulation), and then verify the action in the dialog box that opens, POLY-

FLOW is immediately stopped and then the Solution cell appears as Interrupted.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when next

updated as a result of changes made to upstream cells. For example, if you change the Mesh in an Up-

to-Date Fluid Flow (POLYFLOW) analysis system, the Setup cell appears as Refresh Required, and

the Solution and Results cells appear as Input Changes Pending.
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• Pending ( ) indicates that a batch or asynchronous solution is in progress. This icon will only appear

when the Solution cell is in background mode.

If a particular action fails, Workbench provides a visual indication as well. Brief descriptions of the failure

states are described below.

• Refresh Failed, Refresh Required ( ) indicates that the last attempt to refresh cell input data failed,

and so the cell must be refreshed.

• Update Failed, Update Required ( ) indicates that the last attempt to update the cell and calculate

output data failed, and so the cell must be updated. For example, if you update the Solution cell and

the solver diverges during the calculation, the Solution cell appears as Update Failed, Update Required.

• Update Failed, Attention Required ( ) indicates that the last attempt to update the cell and calculate

output data failed, and so the cell requires attention.

If an action results in a failure state, you can view any related error messages in the Messages window

by clicking the Show Messages button on the lower right portion of Workbench.

1.5. Starting POLYFLOW Applications in Workbench

This section describes how to start POLYFLOW applications in Workbench using POLYFLOW-based systems.

1.5.1. Starting POLYFUSE from a POLYFLOW-Based System

You can open POLYFUSE using the context menu (by right-clicking on the Setup cell of a POLYFLOW com-

ponent system), in order to merge, scale, translate, and rotate meshes.

1.5.2. Starting POLYMAT from a POLYFLOW-Based System

You can open POLYMAT using the context menu (by right-clicking on the Setup cell of a Fluid Flow

(POLYFLOW)analysis system or a POLYFLOW component system), in order to perform preliminary ma-

terial property analyses.

1.5.3. Starting a Preference Editor from a POLYFLOW-Based System

You can open a preference editor using the context menu (by right-clicking on the Setup or Solution

cell of a Fluid Flow (POLYFLOW) analysis system or a POLYFLOW component system), in order to define

your preferences.

1.5.4. Starting POLYDATA from a POLYFLOW-Based System

You can start POLYDATA (i.e., the data generator) by double-clicking on the Setup cell in a Fluid Flow

(POLYFLOW) analysis system or a POLYFLOW component system. POLYDATA launches and loads the

Setup cell’s input data (e.g., mesh) and the Setup cell’s local data, if it exists (e.g., POLYFLOW data).

Note that if you have local data and then you decide to change the mesh and update the system,

Workbench will run consistency checks to make sure the revised mesh is compatible. If no mesh has

been created or imported into the system, POLYDATA cannot be launched.

1.5.5. Starting POLYFLOW from a POLYFLOW-Based System

You can start POLYFLOW by updating the Solution cell in a Fluid Flow (POLYFLOW) analysis system

or a POLYFLOW component system. POLYFLOW launches and loads the current data file (that contains
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a pointer to the mesh file) and performs the corresponding calculation. POLYFLOW cannot be launched

if the Setup cell is not up-to-date (i.e., if the system does not contain valid mesh and data files).

1.5.6. Starting POLYDIAG from a POLYFLOW-Based System

You can open POLYDIAG using the context menu (by right-clicking on the Solution cell of a Fluid Flow

(POLYFLOW) analysis system or a POLYFLOW component system), in order to check the status of the

solver during or after the calculation and analyze the solver performance.

1.5.7. Starting a Listing Viewer from a POLYFLOW-Based System

You can open a listing viewer using the context menu (by right-clicking on the Solution cell of a Fluid

Flow (POLYFLOW)analysis system or a POLYFLOW component system), in order to allow you to open

the listing file during or after the calculation and view what POLYFLOW has done.

1.5.8. Starting POLYCURVE from a POLYFLOW-Based System

You can open POLYCURVE using the context menu (by right-clicking on the Solution cell of a Fluid

Flow (POLYFLOW) analysis system or a POLYFLOW component system), in order to generate plots of

the solution data. Curves can be defined analytically or loaded as files.

1.5.9. Starting POLYSTAT from a POLYFLOW-Based System

You can open POLYSTAT using the context menu (by right-clicking on the Solution cell of a Fluid Flow

(POLYFLOW) analysis system or a POLYFLOW component system), in order to statistically postprocess

results.

1.6. Saving Your Work in POLYFLOW with Workbench

Data that is read into and written by POLYFLOW applications when they are run within Workbench is

split into two parts:

• setup data

• solution data

Setup data is the data used to start a simulation over from the beginning. This data is associated with

the Setup cell and includes the mesh (.msh ) file and the data (.dat ) file.

Solution data is the data that results from performing a calculation and is used to restart a simulation

from existing results. These results are associated with the Solution cell and includes the current data

(.dat ) and results (.res ) files.

The setup and solution data files for a project with one POLYFLOW-based system are saved in a folder

named PFL. When a project has more than one POLYFLOW-based system, additional folders are created

with numeric designations (e.g., PFL-1 , PFL-2 ) for each system’s setup and solution data folders. See

Understanding the File Structure for POLYFLOW in Workbench (p. 34) for additional information about the

file structure for Workbench in POLYFLOW.

When working in Workbench, your work in POLYFLOW is automatically saved as needed. For example,

whenever you close POLYDATA, run POLYFLOW, or save your Workbench project, your unsaved data is

automatically saved.
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You can save your Workbench project by selecting the Save option under the File menu within Work-

bench or by selecting the Save icon from the Workbench toolbar. Note that your attempt to save will

be refused if POLYDATA or POLYFLOW is running.

1.7. Exiting POLYDATA and Workbench

You can end your POLYDATA session by using the Save and exit menu option in the main POLYDATA

menu, or by using the Exit option under POLYDATA’s File menu.

File → Exit

You can end your Workbench session by using the Exit option under Workbench’s File menu.

File → Exit

Note that your attempt to exit Workbench will be refused if POLYDATA or POLYFLOW is running.

1.8. An Example of a POLYFLOW Analysis in Workbench

This example describes when the files that are generated and used by POLYFLOW are written and how

the cell states change as you work with a POLYFLOW-based system in Workbench.

1. Add a new Fluid Flow (POLYFLOW) analysis system to the Project Schematic. The state of the Geometry

cell is Attention Required, while the states for the Mesh, Setup, Solution, and Results cells are Un-

fulfilled.

2. Import a geometry file by using the context menu on the Geometry cell. The state of the Geometry

cell becomes Up-to-Date and the state of the Mesh cell becomes Refresh Required.

3. Double-click the Mesh cell. The ANSYS Meshing application launches and loads the geometry file. The

state of the Mesh cell becomes Update Required.
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4. In the ANSYS Meshing application, specify settings for the mesh, then select the Update command.

The mesh is generated, the mesh (.poly ) file is written, the state of the Mesh cell becomes Up-to-

Date, and the state of the Setup cell becomes Refresh Required.

5. Double-click the Setup cell. The .poly  file is converted into a .msh  file, and then POLYDATA launches

and loads the .msh  file. The state of the Setup cell becomes Attention Required.

6. In POLYDATA, specify physical models, material properties, boundary and process conditions, and field

parameters, and save the data file. The state of the Setup cell becomes Up-to-Date, and the state of

the Solution cell becomes Refresh Required.
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7. Right-click the Solution cell and select the Update option. POLYFLOW launches and the calculations

begin. The state of the Solution cell remains Refresh Required.

When the calculations are completed or the solution meets the convergence criteria, the results

file is written, the state of the Solution cell becomes Up-to-Date, and the state of the Results

cell becomes Refresh Required.

8. Double-click the Results cell. ANSYS CFD-Post launches. ANSYS CFD-Post loads the results file, and the

state of the Results cell becomes Up-to-Date.
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1.9. Getting Help for POLYFLOW in Workbench

Workbench offers three levels of help:

• Quick help - available for most cells in a system. Click the blue triangle in the bottom right corner of

the cell to see a brief help description on that cell. For POLYFLOW-based systems, POLYFLOW-specific

quick help is available for the Setup and Solution cells, providing you with instructions for proceeding

further.

• Sidebar or context-sensitive help - available at any time by clicking <F1>.

• Online help - available from the Help menu, or from any of the links in the quick help or sidebar help.

For more information about Workbench help, see the online documentation.

POLYDATA help is available from the Help menu after the POLYDATA application is running. You can

also access the POLYFLOW product documentation from the ANSYS Customer Portal.
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Chapter 2: Working with ANSYS POLYFLOW in ANSYS Workbench

This chapter provides instructions for using ANSYS POLYFLOW in ANSYS Workbench.

2.1. Generating Meshes in ANSYS Meshing for POLYFLOW

2.2. Importing Mesh and Data Files

2.3. Using the Update Command

2.4. Refreshing POLYFLOW Input Data

2.5. Deleting Solution and Setup Cell Data for POLYFLOW-Based Systems

2.6. Connecting Systems in Workbench

2.7. Duplicating POLYFLOW-Based Systems

2.8. Stopping, Restarting, and Continuing a Calculation

2.9. Using Output Files from a Completed Simulation

2.10.Working with Input and Output Parameters in Workbench

2.11.Viewing Your POLYFLOW Data Using ANSYS CFD-Post

2.12. Understanding the File Structure for POLYFLOW in Workbench

2.13.Working with ANSYS Licensing

2.14. Using Custom Systems

2.15. POLYFLOW Project Templates

2.16. Recording Session Journals with POLYFLOW in Workbench

2.1. Generating Meshes in ANSYS Meshing for POLYFLOW

2.1.1. Named Selections and PMeshes

When generating meshes for POLYFLOW-based systems using the ANSYS Meshing application, note

that you can assign names to the surfaces and volumes of the geometry by defining Named Selections.

Such names will be saved and recognized by any downstream application associated with the mesh,

including POLYDATA, POLYFLOW, POLYFUSE, POLYSTAT, and ANSYS CFD-Post. In this way, you can use

the names of the boundaries and sub-domains to easily identify the corresponding geometric entity.

For example: the boundary where you will impose a given flow rate could be named inflow  or inlet ;

a boundary where the flow will exit the domain could be named outlet  or outflow . This is particularly

useful when you have a large number of boundaries.

When entering a name for a Named Selection, note the following:

• The names should not be too long, as POLYFLOW applications will only retain the last 12 characters of

the names you assign.

• Certain characters are incompatible with POLYFLOW applications, and so will be replaced automatically

with an acceptable character within the POLYFLOW applications. The following characters are replaced

with an underscore (_): dash (- ), space ( ), colon (: ), semicolon (; ), period (. ), comma (, ), exclamation

point (! ), forward slash (/ ), backslash (\ ), left square bracket ([ ), right square bracket (] ), and number

sign / pound / hash (#). Also, an asterisk (* ) is replaced with the letter x . It is recommended that you

try to avoid using such incompatible characters in your Named Selections.

• The names you define should be distinct. If POLYDATA detects identical names, a suffix “_j” will be added

to the names, where j is an index number that makes each of the entities unique.
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You can create Named Selections to specify specialized modeling conditions on edges for 2D or shell

geometry; and edges and faces for 3D geometry. The exported mesh file will contain the mesh nodes

and elements associated with those Named Selections in PMesh format. For 2D geometries, you can

define 1D internal and external PMeshes; for 3D geometries, you can define 2D external PMeshes and

1D and 2D internal PMeshes. Note that the PMeshes cannot be defined on the border. For more inform-

ation about PMeshes, see the POLYFLOW User's Guide.

Note that the downstream POLYFLOW applications assign numerical IDs to the domains, boundaries,

and PMeshes based on the alphabetical order of the names (without consideration of whether the letters

are upper or lower case). These IDs are referenced by POLYDATA and POLYFLOW when reading the

POLYFLOW mesh file (whereas CFD-Post references the name itself ). Therefore, if you delete a Named

Selection after it has been used in a POLYFLOW simulation and recreate a new one with the same name,

the ID will be the same as the original, and you can conduct further simulations without conflict.

2.1.2. CutCell Meshes

The ANSYS Meshing application allows you to generate CutCell meshes, in order to reduce the time

needed to mesh complex geometry. This functionality was originally developed for ANSYS FLUENT, but

it is also compatible with POLYFLOW applications. The CutCell mesher converts a volume mesh into a

predominantly Cartesian mesh (i.e., the mesh consists of mostly hexahedral elements, with faces that

are aligned with the coordinates axes). Smaller elements are used to resolve complex details of the

geometry, and the interfaces between the different size elements are non-conformal (see Figure

2.1 (p. 16)). Note that the POLYFLOW solver will reconnect adjacent elements of different discretization

sizes with conformity constraints, in the same manner as the recursive subdivision of elements technique

used for adaptive meshing (see the POLYFLOW User’s Guide).

Figure 2.1  An Example of a CutCell Mesh

If you want to use the CutCell meshing technique, perform the following steps in ANSYS Meshing:

1. Select the Mesh object in the Tree Outline.

2. Perform the following in the Details view (Figure 2.2 (p. 17)):

a. In the Defaults group, enter CFD for the Physics Preference.

b. Enter Fluent  for the Solver Preference. The only purpose of this step is to activate the CutCell

meshing method within ANSYS Meshing. Note that mesh that is generated by ANSYS Meshing

will be in the POLYFLOW format.

c. In the Assembly Meshing group, enter CutCell  for the Method.
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Figure 2.2  The Details View for CutCell Meshing

Important

Note the following when working with CutCell meshes:

• For flow applications, you must carefully check the generated mesh in order to avoid thin

regions in which only one element exists between opposite walls. If such situation occurs,

all velocity nodes of such elements have fixed (and generally) null values (i.e., a fixed wall

condition): no fluid will cross these elements, leading to artificial obstacles in the flow.

• You must not combine (e.g., using ANSYS POLYFUSE) a mesh that was generated by the

CutCell method with another type of mesh, if you intend to use it in an ANSYS POLYFLOW

simulation; ANSYS POLYFLOW requires that the mesh you read in consists of a domain in

which either every part or no part is a CutCell mesh. Consequently, you cannot use an un-

altered CutCell mesh with moving boundaries (e.g., in a free jet region outside of an extrusion

die), as the remeshing algorithms require a sliceable mesh, which is typically a swept mesh.

To overcome this limitation, you can use POLYDATA to convert a portion of your CutCell

mesh into a sliceable mesh, as described in the POLYFLOW User's Guide.

• CutCell meshes are not compatible with mixing or volume of fluid (VOF) tasks, viscoelastic

flow sub-tasks (see ANSYS FLUENT Meshes Created with ANSYS Meshing, TGrid, and GAMBIT

in the POLYFLOW User's Guide for a comprehensive list), contact detection, internal radiation,

the Narayanaswamy model, flow-induced crystallization, or the adaptive meshing technique.

Moreover, the interpolation for the velocity field is limited: for a pure CutCell mesh, it must

be the linear element; for a portion of a CutCell mesh that has been converted into a sliceable

mesh, it can be either the linear element or the mini-element.

2.2. Importing Mesh and Data Files

You can directly import POLYFLOW mesh and data files into a POLYFLOW-based component system or

analysis system. Note that you must have imported a mesh file before you can proceed to launch

POLYDATA, and both a mesh file and a data file before you can proceed to launch POLYFLOW.

To import the mesh file in a POLYFLOW-based component system, right-click the Setup cell, select the

Import Mesh... option from the context menu, and then select the specific mesh file when prompted.

To import the mesh file in a POLYFLOW-based analysis system, right-click the Mesh cell, select the Import

Mesh... option from the context menu, and then select the specific mesh file when prompted. You can
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also import a mesh file into Mesh-based component system by right-clicking on the Mesh cell and se-

lecting the Import Mesh File... option from the context menu; you can then connect the Mesh cell to

Setup cell of a POLYFLOW-based system, as described in Connecting Systems in Workbench (p. 20).

To import the data file in either a POLYFLOW-based component system or analysis system, right-click

the Setup cell, select the Import POLYFLOW Dat... option from the context menu, and then select the

specific data file when prompted.

After you import a mesh and data file, the state of the Setup cell becomes Update Required. You can

then launch POLYDATA by double-clicking on the Setup cell, and then edit and save the data file; if

you do not need to edit the data file, you can simply right-click the Setup cell and select Update. Then

the Setup cell becomes Up-to-Date and the state of the Solution cell becomes Refresh Required.

When you have a system that contains a Mesh cell or is connected to a Mesh cell in an upstream system,

you should make sure that any data file you import is compatible with the mesh; otherwise, when you

launch POLYDATA, you will be informed that there is an inconsistency between the data and mesh files

and the POLYDATA application will be closed. When there is an incompatibility, you must then decide

whether to delete the connection or Mesh cell (and Geometry cell, if it also exists) and replace it with

a suitable mesh.

Important

In order to postprocess the results from an existing set of mesh and data files in ANSYS CFD-

Post, at least one iteration must be performed in POLYFLOW from within Workbench in order

to bring the state of the Solution cell to Up-to-Date. Alternatively, if you do not intend to

perform any calculations, you could create a Results component system, double-click its

Results cell to open ANSYS CFD-Post and then load the POLYFLOW data file using the Load

Results option under the File menu in ANSYS CFD-Post.

If you have created or imported a mesh, you have the option of importing a pre-existing data file from

within POLYDATA by using the Read an old data file option from the main POLYDATA menu. When

a data file is imported from within POLYDATA using this command, the behavior is exactly the same as

when a file is imported from the Project Schematic.

2.3. Using the Update Command

The Update command is available from the context menu of all cells, from the context menu for the

system, and from the Workbench Toolbar, the Workbench  Tools menu, and the context menu for the

Project Schematic.

When selected from a cell, the Update command updates the current cell and all upstream cells that

must be updated to bring the current cell Up-to-Date. When a cell is updated, any new upstream data

is passed to it before performing the update command.

When selected from the system, the Update command updates all of the out-of-date cells in the current

system, as well as any cells in upstream systems that must be updated to bring the current system Up-

to-Date.

When selected from the Workbench Toolbar, the Workbench  Tools menu, or the context menu for the

Project Schematic, the Update command updates all out-of-date cells in the project.

When updating the Solution cell in a POLYFLOW system, the following steps take place:
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1. POLYFLOW launches.

2. POLYFLOW performs the calculations.

3. POLYFLOW writes the results files.

4. POLYFLOW exits.

The Update command is particularly useful when you make changes to upstream data that impact

downstream data. For example, if you start with an Up-to-Date Fluid Flow (POLYFLOW) analysis system

and then modify the mesh in the ANSYS Meshing application, you can simply select Update from the

system’s context menu to generate the new results.

Important

There is also an Update command in the ANSYS Meshing application which generates the

mesh and creates the input files required by downstream cells. The Generate Mesh command

in the ANSYS Meshing application generates the mesh but does not produce any input files.

If a connection is made from an up-to-date Mesh cell, the state of the Mesh cell may become

Update Required, indicating that the ANSYS Meshing application needs to generate an ad-

ditional input file. This file can be generated by selecting the Update option from the context

menu of the Mesh cell.

2.4. Refreshing POLYFLOW Input Data

You can refresh the input data for a cell by right-clicking on the cell and selecting the Refresh option

from the context menu. The Refresh command passes modified upstream data to the cell but does not

conduct any long-running operations to regenerate the cell’s output data.

For example, you can refresh the mesh by right-clicking on the Setup cell in Workbench and selecting

the Refresh option from the context menu. The state of the Setup cell becomes Update Required. It

will become Up-to-Date the next time you launch POLYDATA from the Setup cell, or if you select the

Update option from the context menu of the Setup cell.

Important

Selecting the Update option from the context menu performs a Refresh command (if needed)

before performing the Update command. You do not need to perform a Refresh and an

Update in two separate steps.

Important

You do not need to refresh the Setup cell if you make a modification to the mesh; the

modified mesh will be loaded automatically when you launch POLYDATA.

Important

If POLYDATA is open and you make a modification to the mesh, you will not be allowed to

refresh the Setup cell unless you first close POLYDATA.
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2.5. Deleting Solution and Setup Cell Data for POLYFLOW-Based Systems

For either type of POLYFLOW-based systems, you can remove all local and generated data from the

Setup cell or from the Solution cell by right-clicking on either cell and selecting the Reset option from

the context menu.

For Setup cells, the Reset option removes the Setup cell’s references to the mesh file, sets the cell

property values to their defaults, and closes the POLYDATA application if it is open. If the Setup cell is

Up-to-Date, it will become Refresh Required when the Reset command is executed.

For Solution cells, the Reset option deletes all data and results files associated with the cell, and sets

the cell property values to their defaults. If the Solution cell is Up-to-Date, it will become Refresh Re-

quired when the Reset command is executed.

2.6. Connecting Systems in Workbench

Workbench allows you to create connections between multiple systems that enable the systems to access

the same data. This is useful, for instance, when you want to compare the results from multiple POLY-

FLOW-based systems in the same ANSYS CFD-Post session. In this case, you would connect the various

Solution cells to one Results cell (either in one of your POLYFLOW-based systems or in a separate

Results system). When you double-click that Results cell, the results from all connected systems will

be loaded into ANSYS CFD-Post at the same time.

Workbench supports two different types of connections:

• Connections that share data are used when the inputs and outputs of the two connected cells are

identical. Shared data connections can only be created between two cells of the same type. Note that

POLYFLOW-based systems can only have shared data connections between Geometry cells and (when

you drag and drop a system) Mesh cells. A shared data connection is represented on the Project

Schematic by a line with a square on its right (target) side (see Figure 2.3 (p. 21)).

• Connections that transfer data are used when the output of one cell is used as the input to the connected

cell. Transfer data connections are usually created between two cells of different types. One exception

is that a transfer data connection can be used between the Solution cells of two POLYFLOW-based

systems when you want to use the current data from one system as the initial data for the other system.

A transfer data connection is represented in the Project Schematic by a line with a circle on its right

(target) side (see Figure 2.3 (p. 21)).

There are four ways to create connected systems in Workbench.

• Right-click a cell in one system, and then drag (i.e., hold the mouse button and move the pointer) and

drop it onto (i.e., release the mouse button while the pointer is over) a compatible cell in another system.

• Left-click a system in the Toolbox, and then drag and drop it onto a compatible system in the Project

Schematic.

• Use the Duplicate command from the Geometry or Mesh cell of a POLYFLOW-based system (see Du-

plicating POLYFLOW-Based Systems (p. 24)).

• Right-click a cell and select one of the options under Transfer Data From New or Transfer Data To

New (these options are not available for all cells).

When you left-click a system in the Toolbox, Workbench highlights all of the compatible drop targets

in the Project Schematic. As you drag the mouse over a drop target, it is highlighted in red and a

message appears in the Project Schematic that informs you what the result will be if you drop the system

onto that target.
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Important

There are usually several compatible drop targets on empty space in the Project Schematic.

Dropping the system onto one of these targets will create a stand-alone system in that loca-

tion.

Similarly, when you right-click a cell and begin to drag it, Workbench highlights all of the compatible

drop targets in the Project Schematic. As you drag the mouse over a drop target, it is highlighted in

red and a message appears in the Project Schematic that informs you what the result will be if you

drop the cell onto that target.

Figure 2.3  Connected Systems Within Workbench

For more information about connecting systems, see the Workbench online help.

2.6.1. Connecting Systems by Dragging and Dropping a System from the

Toolbox onto Another System

The following example demonstrates the procedure for creating connected systems by dragging a

system from the Toolbox and dropping it onto a compatible system in the Project Schematic.

1. Starting from a project with an up-to-date Geometry and Mesh component system, select the POLY-

FLOW-based component system from the Toolbox; the compatible drop targets are highlighted in

green.

2. Drag the system over the Project Schematic and pause over the Mesh cell of the Mesh component

system; the Mesh cell target is highlighted in red and a message informs you that selecting that target

will transfer the data from cell A3 to the new system.
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3. Drop the system on the drop target and a transfer data connection is created between the Mesh cell

A3 and the Setup cell B2.

Note that Mesh cell A3 becomes Update Required, this is because the input data for the new

system has not yet been generated by the ANSYS Meshing application.

4. Right-click Mesh cell A3 and select Update.

5. Double-click Setup cell B2; POLYDATA launches and loads the mesh from cell A3.

In the previous example, a transfer data connection was created. Shared data connections can also be

creating by dragging a system from the Toolbox and dropping it onto a compatible system in the Project

Schematic. The type of connection that Workbench creates depends on which drop target you select.

The red preview messages in the Project Schematic inform you of the type of connection(s) that will

result from your action.

Figure 2.4  Applying the Mesh Settings to a New POLYFLOW-Based Component System

by Dragging and Dropping Systems

2.6.2. Connecting Systems By Dragging and Dropping POLYFLOW-Based

Solution Cells Onto Other Systems

The following figures demonstrate the procedure for creating a transfer data connection by dragging

a Solution cell from a POLYFLOW-based system and dropping it onto a compatible cell in another

system:
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Figure 2.5  An Example of Two Unconnected Systems

Figure 2.6  An Example of Dragging and Dropping a Solution Cell onto Another Compatible

Cell

Figure 2.7  An Example of Two Connected Systems

The following table lists the compatible drop targets for the Solution cell from a POLYFLOW-based

system:

Table 2.1  Connecting Systems By Dragging and Dropping the Solution Cell

To CellFrom Cell

POLYFLOW: Setup (mesh data only)Solution
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To CellFrom Cell

POLYFLOW: Solution (results data only)

Fluid Flow (POLYFLOW): Solution (results data only)

Fluid Flow (POLYFLOW): Results

Results (of any fluid system or a Results system)

Important

As shown in Table 2.1: Connecting Systems By Dragging and Dropping the Solution Cell (p. 23),

the Solution cell cannot be connected to the Setup cell of a POLYFLOW-based analysis

system, whereas it can be connected to the Setup cell of a POLYFLOW-based component

system.

2.7. Duplicating POLYFLOW-Based Systems

Workbench allows you to create a duplicate of a system so that you can set up multiple, similar systems

and analyze them at the same time. For instance, if you would like to study the differences in the fluid

flow between two slightly different geometries, then you can create, set up, and solve a single fluid

flow analysis system, duplicate the entire system, change the geometry in the duplicate system and

perform another fluid flow analysis on the new geometry.

You can create a duplicate of a POLYFLOW-based system by performing the following steps:

1. In the Project Schematic, right-click the system header to open the system’s context menu.

2. Select Duplicate from the context menu.

A copy of the original POLYFLOW-based system is created in the Project Schematic.

All data associated with the POLYFLOW-based system, except for any results files associated with the

Solution cell, are copied to the new system. The states of the Geometry, Mesh, and Setup cells in the

new system will be the same as the states of the cells in the original system. The state of the Solution

and Results cells in the new system will be different than those of the original system if the original

system had results files associated with its Solution cell.

In addition, you can use the Duplicate command to create a duplicate of a POLYFLOW-based system

in which the data in the Geometry cells or the data in both the Geometry cells and the Mesh cells is

shared between the two systems rather than copied.

To create a duplicate system in which the geometry is shared between the original and new system:

1. In the Project Schematic, right-click the Mesh cell in the system you want to duplicate to open the

context menu.

2. Select Duplicate from the context menu.

A copy of the original POLYFLOW-based fluid flow system is created in the Project Schematic. A

shared data connection is created between the Geometry cell in the original system and the

Geometry cell in the new system.

To create a duplicate system in which both the geometry and the mesh are shared between the original

and new system:
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1. In the Project Schematic, right-click the Setup cell or any cell below it in the system you want to du-

plicate to open the context menu.

2. Select Duplicate from the context menu.

A copy of the original POLYFLOW-based fluid flow system is created in the Project Schematic.

Two shared data connections are created: one between the Geometry cell in the original system

and the Geometry cell in the new system, and the other between the Mesh cell in the original

system and the Mesh cell in the new system.

2.8. Stopping, Restarting, and Continuing a Calculation

You can stop the calculation in an interactive POLYFLOW session by clicking the close button ( ) in

the upper right corner of the POLYFLOW window.

You can also stop a POLYFLOW calculation in the background by using the Progress Monitor in Work-

bench. The Progress Monitor is useful if you would like some visual feedback on the progress of your

calculations. Typically, the Progress Monitor is hidden, but can be displayed at the bottom of the Project

Schematic by toggling the Show Progress button.

Figure 2.8  The Show Progress Button in Workbench

When the Progress Monitor is displayed, the Show Progress button becomes the Hide Progress button,

so the button can be used to toggle the display of the Progress Monitor.
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Figure 2.9  The Hide Progress Button, the Progress Monitor and the Stop Button in

Workbench

To stop an ongoing POLYFLOW calculation from Workbench, select the stop button ( ) in the Progress

Monitor (see Figure 2.9 (p. 26)). This will display a prompt (Figure 2.10 (p. 26)), confirming that you want

to stop the calculations.

Figure 2.10  The Workbench Prompt

Clicking Yes in the prompt stops the calculation immediately without concern for whether data associated

with the current action can be stored. If you are running a transient simulation or one that involves

pseudo-evolution, and intermediate results files were generated, the state of the Solution cell becomes

Interrupted; the results can be viewed using ANSYS CFD-Post. Otherwise, the state of the Solution cell

remains Update Required.

After stopping the POLYFLOW calculation, you have two options:

• You can restart the calculation from the beginning. This is accomplished by performing one of the fol-

lowing actions:

– Right-click the Solution cell, select Preferences..., and then select POLYFLOW. Revise at least one

of the parameters in the POLYFLOW options... dialog box that opens, and click OK. Then update

the Solution cell.
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– Right-click the Solution cell and select Reset. Click OK in the dialog box that opens, and then update

the Solution cell.

• If it was a transient simulation or involved pseudo-evolution, you may be able to continue the calculation

from where it was stopped by using the files created in the aborted POLYFLOW calculation, as described

in the following steps:

1. Create a new POLYFLOW-based component system next to the system of the stopped simulation.

2. Import the data file from the stopped simulation into the Setup cell of the new system.

3. If the mesh did not change during the stopped simulation, connect the Mesh cell from the old

system to the Setup cell in the new system; otherwise, you must transfer the last generated mesh

to the new system:

a. Create a transfer connection from the old Solution cell to the new Setup cell (as described

in Connecting Systems in Workbench (p. 20)).

b. Right-click the new Setup cell, move your mouse over Preferences..., and select Mesh

Transfer.

c. In the Select a mesh in the following list dialog box that opens, make sure that Select a

POLYFLOW mesh file is selected from the Import option drop-down list.

d. Make sure that Last mesh is selected from the Select mesh drop-down list, so that the new

simulation uses the last mesh generated by the stopped simulation.

e. Click OK in the Select a mesh in the following list dialog box.

4. Transfer the last restart and results files to the new system:

a. Create a transfer solution data connection from the old Solution cell to the new Solution cell

(as described in Connecting Systems in Workbench (p. 20)).

b. Right-click the new Solution cell, move your mouse over Preferences..., and select Results

Transfer.

c. In the Select results in the following lists dialog box that opens, select Restart with POLY-

FLOW results and restart files from the Import option drop-down list.

d. Make sure that Last restart is selected from the Select restart file drop-down list, so that the

new simulation uses the last restart file generated by the stopped simulation.

e. Make sure that Last results is selected file from the Select results file drop-down list, so that

the new simulation uses the last results file generated by the stopped simulation.

f. Click OK in the Select results in the following lists dialog box.

5. Update the Setup cell in the new system.

6. Update the Solution cell in the new system.

Important

When continuing a calculation that involves adaptive remeshing, you must make sure

that the mesh, restart, and results files are compatible (i.e., all the files are from the same

time step).
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If you would like to view the listing file to see a record of the actions performed by the solver during

the calculation, open the listing viewer as described in Starting a Listing Viewer from a POLYFLOW-Based

System (p. 10).

2.9. Using Output Files from a Completed Simulation

The Select results in the following lists dialog box discussed in the previous section not only allows

you to continue a stopped simulation, but also allows you to transfer results in order to initialize a new

simulation with output files, or to convert output files in a computationally inexpensive way. The sections

that follow provide further details on such uses.

2.9.1. Initializing a New Simulation Using Output Files

In order to initialize a new simulation using the files resulting from a completed simulation (which does

not necessarily need to be transient or involving pseudo-evolution), perform the following actions. First,

follow steps 4.(a) and (b) in Stopping, Restarting, and Continuing a Calculation (p. 25) to open the Select

results in the following lists dialog box. Then make the appropriate selections in the various drop-

down lists:

• If you plan to define the task as an F.E.M. task in the data file of the new simulation, then you can select

one of the following from the Import option drop-down list:

– Restart with a single POLYFLOW results file

– Restart with a single POLYFLOW CSV file

– Restart with POLYFLOW results and restart files

– Restart with POLYFLOW CSV and restart files

• If you plan to define the task as a MIXING task in the data file of the new simulation, then you can

select one of the following from the Import option drop-down list:

– Restart with a single POLYFLOW results file (to initialize the flow field for a steady simulation)

– Restart with a list of POLYFLOW results files (to initialize the flow field with a set of files for a

transient simulation)

After you have made your selection in the Import option drop-down lists, you can select the restart,

results, and/or CSV files that you want to transfer to the new simulation using the other drop-down

lists and click OK. Then you can set up the data file using POLYDATA and proceed with the simulation.

Important

If you setup the Select results in the following lists dialog box in a manner that is valid

for the type of task defined in the data file, your selections will override any attempt within

POLYDATA to select a results file for initialization (e.g., using the Start from an old results

file menu item in the Numerical parameters menu). However, invalid setups (e.g., selecting

Restart with a single POLYFLOW CSV file for a data file defined as a MIXING task) will not

override your POLYDATA setup.

2.9.2. Converting Output Files

By running POLYFLOW in Workbench, you can more quickly and efficiently convert your POLYFLOW output

files into other file types. By transferring results between POLYFLOW-based systems and using the Select

results in the following lists dialog box, the conversion of files can be performed without requiring
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the solver to calculate the full simulation. The following examples demonstrate how to convert a results

file into a particular kind of postprocessing file, and how to convert CSV files into a results file.

2.9.2.1. Example 1

Consider a situation in which you have run a simulation, but did not set up the data file to generate

output files for an external postprocessor, such as FIELDVIEW. If you then decide that you would like

to view the results in FIELDVIEW, you can convert a results file from the simulation in the following way:

1. Create a new POLYFLOW-based component system next to the system of the completed simulation.

2. Transfer the mesh to the new system: if the mesh did not change in the original simulation, connect

the old Mesh cell to the new Setup cell; otherwise, perform steps 3.(a)–(e) in Stopping, Restarting, and

Continuing a Calculation (p. 25).

3. Transfer the old results file to the new system:

a. Create a transfer solution data connection from the old Solution cell to the new Solution cell (as

described in Connecting Systems in Workbench (p. 20)).

b. Right-click the new Solution cell, move your mouse over Preferences..., and select Results

Transfer.

c. In the Select results in the following lists dialog box that opens, make sure that Restart with

a single POLYFLOW results file is selected from the Import option drop-down list.

d. Select the results file that you want to convert from the Select results file drop-down list. For

example: if it was a steady solution, select Last results; if it was a transient solution, you can select

any results file of interest, as long as it is compatible with the transferred mesh.

e. Click OK in the Select results in the following lists dialog box.

4. Set up a data file for the new system to convert the old results file.

a. Double-click the Setup cell to open POLYDATA.

b. Click Convert old result files in the main POLYDATA menu.

Convert old result files

The Convert old result files menu will open. Note that the top of the menu reports that the

.msh  and res  files generated by the old system is selected for conversion.

c. If it is a 2D simulation, click Modify type of simulation.

Modify type of simulation

The Type of simulation menu will open. Click the menu item that accurately conveys the

kind of simulation you are performing and then click Accept the current setup.

d. Click Select outputs.

Select outputs

The Outputs menu will open.

e. Click the menu item for the output file you would like to generate, such as Enable FieldView

UNS output.
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Enable FieldView UNS output

f. Click Upper level menu to return to the previous menu.

g. Click Save and Exit, and then Accept and Continue in the menus that open.

5. Update the Solution cell of the new system. When the simulation is complete, the output files can be

found in the Outputs  subfolder.

2.9.2.2. Example 2

Consider a case where you want to run a simulation that involves moving parts with adaptive meshing

(e.g., a batch mixer which has a transient flow and utilizes the mesh superposition technique), and you

would like to perform particle tracking so that you can then conduct a statistical analysis. Unfortunately,

it is not possible in POLYFLOW to perform particle tracking when the flow domain changes. To resolve

this problem, you can convert the CSV files into a set of results files, and then use the results files to

compute a set of trajectories for your statistical analysis, as described in the following steps:

1. Run the moving part simulation with adaptive meshing using POLYFLOW in Workbench, generating

*.msh  and *.csv  files for each time step.

2. Create a new POLYFLOW-based component system in the Project Schematic.

3. Connect the Mesh cell from the first system to the Setup cell in the second system (as described in

Connecting Systems in Workbench (p. 20)).

4. Transfer the CSV files generated by the first system to the second system:

a. Create a transfer solution data connection from the first Solution cell to the second Solution cell

(as described in Connecting Systems in Workbench (p. 20)).

b. Right-click the second Solution cell, move your mouse over Preferences..., and select Results

Transfer.

c. In the Select results in the following lists dialog box that opens, select Restart with a list of

POLYFLOW CSV files from the Import option drop-down list.

d. Select one of the CSV files generated by the first simulation from the Select results file drop-

down list. Note that the prefix of this CSV file will be used by POLYDATA to identify all of the

other related CSV files, so that the entire set is converted.

e. Click OK in the Select results in the following lists dialog box.

5. Set up the data file for the second system using POLYDATA.

a. Select the Convert old csv files menu item from the main POLYDATA menu:

Convert old csv files

Then use the menu items in the Convert old csv files menu to define whether you want to

convert a single or multiple CSV files from the first simulation; if you are converting multiple

files, indicate the starting and ending indices of the files to convert.

b. You have the option of setting up the data file to refine the mesh uniformly, by defining the level

of refinement and the domain.

c. Specify that you want POLYFLOW output produced by clicking Outputs in the main POLYDATA

menu.

Outputs
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Then click Enable Polyflow output in the menu that opens.

Enable Polyflow output

You may then use this menu to enable other desired postprocessor output types.

d. Click Save and exit in the main POLYDATA menu.

Save and exit

6. Update the Solution cell of the second system, thus creating a unique mesh and set of results files.

7. Create yet another POLYFLOW-based component system in the Project Schematic.

8. Transfer the mesh created by the second system to the third system:

a. Create a transfer connection from the second Solution cell to the third Setup cell (as described

in Connecting Systems in Workbench (p. 20)).

b. Right-click the third Setup cell, move your mouse over Preferences..., and select Mesh Transfer.

c. In the Select a mesh in the following list dialog box that opens, make sure that Select a

POLYFLOW mesh file is selected from the Import option drop-down list.

d. Select the mesh generated by the second simulation by selecting Mesh (refinement step)

[formatted] from the Select mesh drop-down list.

e. Click OK in the Select a mesh in the following list dialog box.

9. Transfer the results files generated by the second system to the third system:

a. Create a transfer solution data connection from the second Solution cell to the third Solution

cell.

b. Right-click the third Solution cell, move your mouse over Preferences..., and select Results

Transfer.

c. In the Select results in the following lists dialog box that opens, select Restart with a list of

POLYFLOW results files from the Import option drop-down list.

d. Select one of the results files generated by the second simulation by selecting Result(conv. step

<#>)[formatted] from the Select results file drop-down list, where <#> is the ID of the conversion

step. Note that the prefix of this results file will be used by POLYDATA to identify all of the other

related results files, so that the entire set is loaded.

e. Click OK in the Select results in the following lists dialog box.

10. Set up the data file for the third system using POLYDATA, such that mixing task computes a set of

trajectories.

11. Update the Solution cell of the third system.

12. Launch POLYSTAT by right-clicking on the third Solution cell and selecting POLYSTAT, and run a

statistical analysis of the mixing based on the trajectories.
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Figure 2.11  Project Schematic for Converting CSV Files

2.10. Working with Input and Output Parameters in Workbench

Workbench uses parameters and design points to allow you to run optimization and what-if scenarios.

You can define input parameters in POLYDATA that can be used in your Workbench project. You can

also define parameters in other applications including ANSYS DesignModeler and ANSYS CFD-Post. After

you have defined parameters for your system, a Parameters cell is added to the system and the Para-

meter Set bus bar is added to your project. Arrows representing input and output parameters connect

the bus bar to each system in which you have defined parameters.

Double-click the Parameter Set bus bar to open the Parameters workspace. The parameters workspace

includes the Outline of All Parameters table that lists all of the parameters in your project as well as

the Table of Design Points table in which you can specify design points.

To create a new design point, enter the input parameter values that you want to use for that design

point in the Table of Design Points in the row with an asterisk (*) in the first column. You can create

several design points. After you have finished specifying design points, you can right-click the row for

one design point and select the Update Selected Design Point option from the context menu to

compute the output parameters for that design point. Alternatively, you can select Update All Design

Points from the Toolbar to update all of your design points in sequence.

Important

Only the data from the design point in the row labeled Current is saved with the project. If

you want to postprocess the results from a different design point in ANSYS CFD-Post, click

the box in the Exported column for that design point before you update that design point.

Otherwise, the data for that design point is automatically deleted after the output parameters

for that design point are updated. If you choose to export a design point, the data associated

with that design point is exported to a new project. The new project is located in the same

folder as the original project. The name of the project is the same as the name of the original

project, except that it is appended with _dpn, where n is the row number that corresponds

to the design point in the original project’s Table of Design Points.

For more information about input and output parameters in POLYFLOW, see the POLYFLOW User’s

Guide.

For more information about parameters, design points, what-if scenarios and optimization studies in

Workbench, see the Workbench online documentation.
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2.11. Viewing Your POLYFLOW Data Using ANSYS CFD-Post

ANSYS CFD-Post is an application you can use to visualize the results of your POLYFLOW CFD simulations.

For POLYFLOW-based analysis systems, the Results cell provides access to the ANSYS CFD-Post applic-

ation. In addition, the Toolbox contains a separate Results component system (i.e., ANSYS CFD-Post)

that you can add to the Project Schematic and connect to POLYFLOW-based systems.

When a Results cell is connected to a POLYFLOW-based system’s Solution cell and the state of the

Results cell is Refresh Required or Up-to-Date, you can view the results of the POLYFLOW calculation

in ANSYS CFD-Post by double-clicking the Results cell. This will start ANSYS CFD-Post and load the

results file from POLYFLOW. If the state of the Results cell is Input Changes Pending, it indicates that

the POLYFLOW calculation can be rerun, in which case the results data will be changed by overwriting

the existing results file.

When viewing the results of POLYFLOW simulations in ANSYS CFD-Post under Workbench, the CFD-
POST_WB_FORCE_RELOAD environment variable should be set to 1 to ensure that you can reload

updated results. POLYFLOW results are saved in a .res  file, and when the solution data is updated,

the .res  file is overwritten (e.g., if you have run a simulation and compute a new solution with revised

design parameters, the results data will be written to the same .res  file as the previous solution).

Setting this environment variable will allow the results to be updated when you refresh the Results

cell, or when you elect to load the new results from within ANSYS CFD-Post via the dialog box that

opens when the new solution is calculated.
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Figure 2.12  POLYFLOW Results Loaded into ANSYS CFD-Post

2.12. Understanding the File Structure for POLYFLOW in Workbench

When you save a Workbench project (e.g., my-project ), the project is saved with a .wbpj  extension

(e.g., my-project.wbpj ). Other files associated with the project (through other Workbench applications

such as POLYFLOW) are located in the dp0  folder within a _files  folder (e.g., my-project_files ).

Note that additional dp  folders (e.g., dp1 , dp2 ) are created when additional design points are specified

using the Parameter Set bus bar.

Each system in the Project Schematic has its own folder under the dp0  folder. The folder is named using

the corresponding system identifier (e.g., PFL represents a POLYFLOW-based analysis or component

system; Post  represents a Results component system). The folder name is appended with a number

to distinguish it from the folders for other systems of the same type (with the exception of the folder

name for the first system of a specific type, which has no number appended to it).

Within each system folder is a folder for each application that is part of the system. This folder is used

to store the files generated and used by the application.
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Figure 2.13  Overview of the Folders for a POLYFLOW-Based Project in Workbench

The following POLYFLOW files are managed by POLYFLOW in Workbench:

• mesh files (*.msh )

• data files (*.dat )

• results files (res*  and *.res )

• restart files (*.rst )

• listing files (*.lst )

• preferences files (*.p3rc )

• publishing files (*.pub )

• clips files (*.clp )

• mixing files (*.mix )

• CSV files (*.csv )

• probe files (*.prb )

• curve files (*.crv )

• statistical curve files (e.g., *.dns  and *.dsp )

• monitor files (*.cnvg )

• batch files (*.bat )

• locking files (*.lok )
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• material files (*.mat )

• UDF files (*.udf )

• console files (*.cons )

• listing files (*.log )

• POLYDATA session files (*.ses )

• POLYFUSE session files (*.fus )

• POLYSTAT session files (*.sav )

• POLYCURVE, POLYMAT, and POLYSTAT canvas files (*.can )

• POLYMAT, POLYSTAT, and POLYCURVE encapsulated PostScript files (*.eps )

The following files from other applications are also managed by POLYFLOW in Workbench:

• GAMBIT neutral files (*.neu )

• POLYCEM neutral files created by ANSYS ICEM or the Workbench Meshing application (*.poly )

• ANSYS CFD-Post files (cfx*.res  and *.trn )

You may use other types of files with POLYFLOW in Workbench, however, you are responsible for

making sure that they are located in the appropriate folder within the project file structure.

Figure 2.14 (p. 36) shows an example of the folder structure for a Workbench project with two Fluid

Flow (POLYFLOW) systems and one Results system.

Figure 2.14  Example of the Folder Structure for a POLYFLOW-Based Project in Workbench

You can view the files associated with your Workbench project by selecting the Files option under the

View menu.
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View → Files.

Figure 2.15  The Files View for a Project in Workbench

If data is shared between two systems, then files are also shared between the two systems. The shared

file will exist in either the folder of the first system that used it, or in a global folder in the design point

folder (depending on the type of system that generated the file).

The _files  folder also contains a user_files  folder. This folder should be used for any files you

create or reference that you would like to store with the project.

Important

Output files are written to the Workbench folder by default. Because the files are managed

by Workbench, it is recommended that you do not save files to a different location.

Important

It is recommended that you import all input files (e.g., UDF files, .crv  files) in the project

and to reference those files in ANSYS POLYDATA; by doing this, you will create a copy of the

input file in the project folder, and thus make it possible for you to move the project folder

with all the files included.

2.12.1. POLYFLOW File Naming in Workbench

When running under Workbench, POLYFLOW automatically saves the mesh, data and output files for

your system as needed in the PFL folder or subfolder. The following describes the naming conventions

for these files:
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• .msh  file

If a .msh  file is imported into the system, the file retains its original name. If a .poly  or .neu  file

is imported, the file is converted into a file named convert.msh .

• .dat  file

If a .dat  file is imported into the system, the file retains its original name. If a new .dat  file is

created using POLYDATA, the file is named polyflow.dat .

• POLYFLOW results file

The POLYFLOW results file in the Outputs  folder is named res .

• output mesh file

The output mesh file in the Outputs  folder is named res.msh .

• ANSYS CFD-Post file

The ANSYS CFD-Post file in the Outputs  folder is named cfx.res .

The following example shows how file naming works in POLYFLOW under Workbench:

1. Launch Workbench.

2. Save the Workbench project file as my_project .

File → Save As...

A file named my_project.wbpj  is saved, along with a folder named my_project_files .

3. Create a POLYFLOW-based analysis system, as described in Creating POLYFLOW-Based Systems (p. 3).

4. Right-click the Mesh cell and select Import Mesh File.... Then select the POLYFLOW mesh file ex-
tru3d.msh  using the file browser that opens and click Open.

5. Double-click the Setup cell to launch POLYDATA and set up material data and boundary conditions

in the usual manner. After you click the Save and Exit menu item in the main POLYDATA menu (and

then the Accept and Continue menu items), a polyflow.dat  file is created.

6. Right-click the Solution cell and select Update, in order to launch the POLYFLOW solver. At the end

of the calculation, a listing file named polyflow.lst  is created in the my_project_files

∖dp0∖PFL∖PFL folder, while the following files are created in the my_project_files

∖dp0∖PFL∖PFLOutputs  folder: a POLYFLOW results file named res ; a POLYFLOW output mesh

file named res.msh ; an ANSYS CFD-Post result file named cfx.res ; a series of .cnvg  files summar-

izing the convergence history of main computation fields; and a series of .prb  files containing the

values of fields at the different probe locations.

7. Save the project: File → Save.

2.13. Working with ANSYS Licensing

When working with Workbench, you have the option to share a single license between applications

that use the same license or the option for each application to check out its own license.
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2.13.1. Shared Licensing Mode

When using shared licensing, although a single license is shared between multiple applications, only

one application can actively use the license at a time. For example, with just a single license, you cannot

do anything in the ANSYS CFD-Post session if iterations are being performed in the POLYFLOW session.

Note that it is possible to keep a POLYDATA application open and then launch another session of

POLYDATA, a POLYFLOW calculation, or an ANSYS CFD-Post session. When the window(s) of the applic-

ation (not the current one) is inactive, the license used by POLYDATA is released enabling another ap-

plication to use this released license.

If you open an application, it will first check to see if it can use a license that is already checked out. If

it can, and that license is available, it will use that license. If the license is not available because it is

being used by another application, you will be informed that the required license is not available. You

will not be able to use the new application until that license becomes available. If there is not a license

checked out that is compatible with the new application, the new application will check out an addi-

tional license. If POLYDATA is open, the license will not be released unless the window(s) of the applic-

ation is inactive. If one application window becomes inactive, another application will be active, and

thus will take the license. When POLYDATA is active again, other applications release their licenses.

POLYDATA will request for a license. If one is available, POLYDATA will take it and you can continue

working in POLYDATA. If no license is available, the following warning will be displayed on the screen:

Communication problem.
Shared license cannot be reacquired. 
Do you want to save and close your session? 
Answer ‘No’ to request license again. 

In shared mode, you can only have one license of each type of shareable license checked out at a time.

For example, you can have 1 acfd  license and 1 acfd_polyflow  license checked out at the same

time but you cannot have 2 acfd  licenses checked out at the same time.

POLYFLOW in Workbench can operate in shared and non-shared mode. In shared mode, a single

POLYFLOW license is shared between the applications in a single session. In non-shared mode, each

application will check out an individual license as it is opened. Hence you can only open as many ap-

plications as there are licenses. Parallel (HPC) licenses cannot be shared by applications, in both shared

and non-shared modes.

For more information about licensing and shared license mode, please see the Workbench online doc-

umentation.

2.14. Using Custom Systems

Workbench provides system templates, which contain connected systems that are appropriate for

common applications (e.g., fluid-structure interaction). Note that for the system templates, upstream

data does not exist for the Setup cells (i.e., they are Unfulfilled), as opposed to the POLYFLOW project

templates described in the section that follows, in which the Setup cells have data and are Up-to-Date.

To use a system template, double-click it under Custom System in the Toolbox.

You can also create your own system template and then save it as a Custom System by performing

the following steps:

1. Manually create the desired system diagram in the Project Schematic.

2. Right-click on white space in the Project Schematic and select Add to Custom from the context menu.

3. Enter a Name in the Add Project Template window that opens, and click OK.
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2.15. POLYFLOW Project Templates

You have access to a series of POLYFLOW project templates, each of which is a Workbench project file

for a common POLYFLOW simulation, which you can modify in order to quickly and easily set up your

own problem. These templates contain all the elements of a complete simulation, from geometry (or

mesh) to postprocessing, and include design parameters and a predefined CFD-Post report. Note that

for the POLYFLOW project templates, the Setup cells have data and are Up-to-Date, as opposed to the

system templates described in the previous section, which do not have upstream data for the Setup

cells (i.e., they are Unfulfilled).

After loading the template in Workbench, you can hook your own geometry or mesh to the POLYFLOW

system and modify the setup via Design Exploration. By simply clicking Update Project, you will auto-

matically run the simulation and create the report corresponding to your flow domain and operating

conditions.

The templates are located within in the following directories:

• For Linux:

path/ansys inc/v140/polyflow/polyflow14.0. �/Templates

• For Windows:

path\ANSYS Inc\v140\polyflow\polyflow14.0. �\Templates

where path is the directory in which ANSYS POLYFLOW has been installed, and � represents the appro-

priate number for the release (e.g., 0 for polyflow14.0.0 ).

Each template is stored in an individual directory, and is comprised of:

• an archived Workbench project file (.wbpz )

• an HTML file that is the output of the predefined report of the CFD-Post file saved in the project, which

describes the setup

2.15.1. Choosing a POLYFLOW Project Template

The templates solve flow problems in the three main applications of POLYFLOW: blow molding, extrusion,

and thermoforming. For your convenience, the templates are grouped by application in subdirectories

(named after the application) under the Templates  directory. Note that the blow molding and ther-

moforming problems require a POLYFLOW license or a license for the blow molding application-specific

version of POLYFLOW, while the extrusion problems require a POLYFLOW license or a license for the

extrusion application-specific version of POLYFLOW.
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To choose an appropriate template, find the closest match to your problem in the following tables. You

can find additional information in the HTML file provided in the template directory.

Table 2.2  Blow_Molding Template

DescriptionTemplate Name

An isothermal blow molding process of a middle-sized object, with

dimensions on the order of 30 cm.

01_BlowMoulding_35cm

Table 2.3  Extrusion Templates

DescriptionTemplate Name

A 3D flow in a die, with an inlet, an outlet, and a zero velocity condition

applied to a wall.

1_Die_InletWallOutlet

A 3D flow in a die, with an inlet, an outlet, and a slip condition applied

to a wall.

2_Die_InletSlipWallOut-
let

A 3D flow in a die, with an inlet, a plane of symmetry, an outlet, and

a zero velocity condition applied to a wall.

3_Die_InletWallSymOut-
let

A 3D flow in a die, with an inlet, a plane of symmetry, an outlet, and

a slip condition applied to a wall.

4_Die_InletSlipWallSy-
mOutlet

A 3D flow in a die and free jet, with an inlet, a free surface, an outlet,

and a zero velocity condition applied to a wall.

5_Direct_InletWallFree-
JetOutlet

A 3D flow in a die and free jet, with an inlet, a free surface, an outlet,

and a slip condition applied to a wall.

6_Direct_InletSlipWall-
FreeJetOutlet

A die design for a flow with an inlet, a wall, a free surface, and an

outlet.

7_Inverse_InletWallFree-
JetOutlet

A die design for a flow with an inlet, a free surface, an outlet, and a

slip condition applied to a wall.

8_Inverse_InletSlipWall-
FreeJetOutlet

Table 2.4  Thermoforming Templates

DescriptionTemplate Name

An isothermal thermoforming process of a small object, whose typical

dimension is on the order of a centimeter. The geometric model is

01_Thermoforming_1cm

based on a shell representation for both the polymer sheet and the

mold. The constitutive material has a constant viscosity.

An isothermal thermoforming process of a small object whose typical

dimension is on the order of 10 centimeters. The geometric model is

02_Thermoforming_10cm

based on a shell representation for both the polymer sheet and the

mold. The constitutive material has a constant viscosity.

An isothermal thermoforming process of a small object, whose typical

dimension is on the order of a meter. The geometric model is based

03_Thermoforming_1m

on a shell representation for both the polymer sheet and the mold.

The constitutive material has a constant viscosity.
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2.15.2. Using a POLYFLOW Project Template

After you have selected the template that corresponds to your needs, you can open the project file in

Workbench. The project files are archived as .wbpz  files, and so to open them, you can: use the Restore

Archive option under the File menu in Workbench; browse to the file, unzip it, and then open it in the

normal fashion; or, in Windows, browse to the file and double-click it.

Two or three systems will then appear in the Project Schematic: a POLYFLOW system connected to a

Results system and, in cases where a geometry is provided, a Mesh system connected to the POLYFLOW

system. A Parameter Set bar allows you to modify the parameters, design points, and properties.

It is recommended that you run the calculation at least once with the provided geometry/mesh, in order

to get some experience with the template. You can then hook your own geometry/mesh, modify the

values defined by the Parameter Set bar to suit your needs (see the HTML report in the template dir-

ectory for a summary of the predefined values), and simply hit the Update Project button. If the nature

of the predefined values do not fit your needs, you can open POLYDATA via the Setup cell of the

POLYFLOW system and adapt any of the details.

Note that the HTML report is not generated automatically, and so you must use the File/Report/Publish

menu option in CFD-Post if you want a report.

2.16. Recording Session Journals with POLYFLOW in Workbench

You can keep a history of your interactions within Workbench by recording your interactions with the

program(s) in session journals. Note that these journals can record your interactions with POLYFLOW-

based systems, but any of the manual inputs you make within the POLYFLOW applications will not be

recorded. An example of when it might be useful is when you have an existing setup and you are up-

dating the geometry, mesh, or connections between systems.

Session journals are recorded using File → Scripting → Record Journal....

Additionally, you can use the Workbench  File → Scripting → Run Script File... to play back a previously

recorded session journal:

For more information about recording and using session journals, as well as reference documentation

containing available commands, see the separate Workbench online documentation.
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